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E Fundamental of Computer

Chapter
A. 1. (c}; 2.(a); 3.(b); 4.(a); 5. (c)
B. 1. True; 2. True; 3. False; 4. True; 5. False
C. 1. brain; 2. photocopier; 3. output; 4. barcodes; 5. tracks, sectors
D. 1, Acomputer basically performs five major operations or functions :
(a) It accepts data or instructions by way of inputs.
(b) It stores data.
(c} It can process data required by the users.
(d) It gives result as an output.
(e) It controls all operations inside the computer.

2. The modern age is the age in which the electronic machines like computers have been
invented. The computer was not invented by just one person. It was the outcome of a
sequence of a contributions of many people.
The history of computers started in 1939 with Howard Aiken and Mark-Il. But it was long
before, when the design of an automatic computer was conceived by an inventor Charles
Babbage, a British mathematician. He is also known as “the father of computers.” This
machine used a different method of computation, so Babbage called the machine difference
engine, but this project was flop. Then Babbage desighed another machine, an analytical
engine whose design and features were remarkable and close to the modern computers
with capabilities of storing program. But again this idea could not succeed.
In 1937, Howard Aiken of Harward University designed a machine called Mark-l. Mark-1 was
capable of automatically performing a long sequence of arithmetical and logical operations
and preparing the mathematical tables which was a time consuming and error prone task.
Design of Mark-l completed in 1944,

3, The CPU performs the following functions :
(a) It takes logical decisions.
(b) It performs arithmetic functions.
(c} It controls the activities of all the other units.

4. (a) Optical Character Reader (OCR) : An Optical Character Reader is used to read character

of special type font printed on conventional paper with conventional ink. The printed
characters are examined by passing them under a strong light and a lens system, which
differentiates light from inked areas, and a logical system which attempts to determine
which of the possible characters is being examined.

(b) Barcode Reader : A barcode reader or barcode scanner is an electronic device for
reading printed barcodes. A barcode is a printed horizontal strip of vertical bars which
are used for identifying specific items. It consists of a light source, a lens and a light
Sensor.



(c} Magnetic Ink Character Reader : Magnetic Ink Character Reader is an input device used
for character recognition technology by the banking industry to facilitate the processing
of cheques and debit/credit cards. The technology allows computers to read information
(such as account numbers) from printed documents.

(d) LCD Projector : An LCD projector is a type of video projector for displaying video images
or computer data on a screen. It is commonly used in organizations for displaying
PowerPoint presentations during meetings.

. Software consists of all the components that we cannot touch. Software is a set of programs.

A program is a set of instructions that tells the computer to perform tasks.
Software can be classified into two categories :
(a) System Software : System software refers to those programs which are responsible for

the smooth functioning of a computer. They comprise of operating systems, compilers,
interpreters and many other utility programs.

(b) Application Software : Application software refers to the software that have been
designed to meet user requirements. MS Word, MS Excel, MS PowerPoint, etc. are some
popular application software.

. The internal memory is the in-built memory where CPU holds the programs and data being

manipulated. RAM and ROM are the internal memories.

Whereas the storage inside main or internal memory is temporary. When this temporary
information is to be stored permanently or semi-permanently, external memory is used.
Most common external storage devices are hard disks, floppy disks, magnetic tapes, CD
ROM, Video disks, etc.
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Chapter
1.

. False; 2. True; 3. True; 4. False; 5. True
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MS-Word : Advanced Features

(b); 2. (c); 3. (a); 4. (a); 5. (b)

. type-writer; 2. Status; 3. endnote; 4. vertical; 5. hyperlinks
. Header : Header is placed at the top of a page of a document.

Footer : The footer is placed at the bottom of the page in the document.

. Footnote : A footnote is generally placed at the bottom of a page.

Endnote : The endnote comes at the end of a document. The endnote is mostly used to give
references for the sources of the text.

. Paragraph formatting is the changing and arranging text in a paragraph to make it attractive.

Steps to align the paragraph are :
Step-1 : Select the paragraph or place cursor within the paragraph.
Step-2 : Click Home tab, then click appropriate alignment option from the Paragraph group.

. Mail merge is a tool which allows us to creates form letters, mailing labels and envelopes by

linking a main {common) document to a set of data or data source.
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5.

To Insert a hyperlink, follow the given steps :
Step-1: Select the text or image we want to make a hyperlink.

Step-2 : Right-click the selected text or image, then click Hyperlink. We can also right-click in
a blank area of the document and click Hyperlink.

Step-3 : The Insert Hyperlink dialog box will appear. We can also get to this dialog box from
the Insert tab by clicking Hyperlink.

Step-4 : If we selected text, the words will appear in the Text to display field at the top. We
can change this text if we want.

Step-5 : Type the address we want to link to in the Address field.
Step-6 : Click OK. The text or image we selected will now be a hyperlink.

. Drop Cap is a feature provided by MS Word in which the first character of the paragraph is

bigger, and dropped on the subsequent lines of the paragraph to mark the beginning of
paragraph. You can use this feature while writing stories.
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. True; 2. False; 3. True; 4. True; 5. False
. cell; 2. pictorial; 3. Functions; 4. maximum; 5. password
. The Features of MS-Excel are :
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MS-Excel Spreadsheets

(d); 2. (b); 3. (c); 4. (b); 5. (d)

(a) Excel spreadsheets include a number of built in formulas used for common tasks known
as functions.

(b) Excel 2010 retires the Chart Wizard and offers us direct access to all the major types of
charts on the Ribbon’s Insert tab.

(c} Data can be entered in series using the Autofill option.
(d) The data gets automatically recalculated if any change is made in a single cell.

. The steps to create table in MS-Excel are :

Step-1: On a worksheet, select the range of cells that you want to include in the table. The
cells can be empty or can contain data.

Step-2 : On the Home tab, in the Styles group, click Format as Table, and then click the table
style that you want.

Step-3 : If the selected range contains data that you want to display as table headers, select
the My table has headers check box in the Format as Table dialog box.

Table headers display default names if you do not select the My table has headers check box.
You can change the default names by selecting the default header that you want to replace,
and then typing the text that you want.

. Charts {graphs) are the pictorial representation of worksheet data. Charts present worksheet

data in graphical or pictorial form, which is easier to read and understand.
Its types are as follows :



(a) Area chart : An area chart emphasizes the magnitude of change over time.

(b) Column Chart : A column chart shows data changes over a period of time or illustrates
comparisons among items.

(c} Bar Chart : A bar chart illustrates comparisons among individual items.

(d) Line Chart : A line chart shows trends in data at equal intervals. Line charts are useful for
depicting the change in a value over a period of time.

(e) Pie Chart : A pie chart shows the proportional size of items that make up a data series to
the sum of the items.

. A cell reference refers to a cell or a range of cells on a worksheet and can be used in a
formula so that Microsoft Office Excel can find the values or data that we want that formula
to calculate.

. Row : A row is a horizontal line of boxes. Rows are labelled as 1, 2, 3, etc. These row labels
appear on the left of each row. There are 1,048,576 rows in an Excel sheet.

Column : A column appears vertically. Columns are labelled as A, B, C, etc. There are 16,384
columns in an Excel sheet.

. A function is a built-in formula in MS-Excel that is used to carry out common mathematical
calculations. Functions save us from writing lengthy formulae.

In Excel, we should write function in a specific order called syntax.

Functions should begin with the (=) or @ sign followed by the function name. SUM or AVG is
a function name.

The third part is arguments. It can be numbers, text or cell reference. Arguments are
enclosed within parentheses (). When there is more than one argument, each is separated
by a comma.

(a) Equal sign — =SUM (B3 : B10) « Argument
Function name

This is an example of a function with one argument.

(b) Equal sign — = AVG (B3 : B10, C3 : C10} « Argument
FuncticI‘l name

This is an example of a function with more than one argument,
. The steps to filter data in an Excel worksheet are :
Step-1: Click on any cell within the data.
Step-2 : Click on the Data tab.
Step-3 : Now click on the Filter button.
Step-4 : Click on the drop-down arrow next to the heading we would like to filter.
Step-5 : Click Ok. We can see only data which we select in Step-4.

. The Conditional Formatting option allows us to format cells in a worksheet depending on
whether they meet a prescribed condition or not.
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MS PowerPoint : Advanced Features

Chapter
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5.

. (c}); 2. (a); 3. (d); 4. (b); 5. (c)
. True; 2. True; 3. False; 4. True; 5. False
. slides; 2. picture; 3. Slide Show; 4. slide; 5. presentation.

. A ‘presentation” means collection of information and then presenting the information with

impressive and illustrative materials such as visual graphics, texts and pictures in an
organized way.

. The various steps to insert a Clip Art are :

Step-1: Go to Insert tab to select Clip Art button from lllustrations group. The Clip Art task
pane will appear.

Step-2 : In the Search for box, type the word or phrase of the picture to be inserted and click
on the Go button.

Step-3 : The list of pictures will appear in the task pane.
Step-4 : Click on the Clip Art to insert it in the slide.

. Animation is the process by which multiple pages are displayed rapidly in a sequence such

that the images appear to be in motion. It is the addition of special visual/sound effects to
the text and graphics on a slide.

Animation can be used for any or all of the following purposes :
(a) To emphasize on important information in the slide.
(b) To control the order in which information is displayed on the slide.

(c} To hold the attention and interest of the audience.

. PowerPoint Presenter View is a great way for us to view our presentation with our speaker

notes on one computer, while the audience views the notes-free presentation on a different
moenitor. In Presenter View, icons and buttons are large enough to navigate easily, even
when we are using an unfamiliar keyboard or mouse.

Presenter View offers the following tools to make it easier for us to present information :

(a) We can use thumbnails to select slides out of sequence and create a customized
presentation for our audience.

(b) Speaker’s notes are shown in large, clear type so that we can use them as a script for our
presentation.

(c} We can darken or lighten the screen during our presentation and then resume where we
left off.

The various steps to add speaker notes are as follows :
Step-1: Select the slide.

Step-2 : Go to View tab of MS-PowerPoint window and select Notes Page option from the
Presentation View group. A click to add text section appears below the slide.



6.

Step-3 : Type in the notes for that slide.

While designing and running a presentation, the following points should be kept in
mind :

(a) Slides should be of a consistent design throughout the presentation.
(b) Use graphics and pictures to make the presentation attractive.

(c} Remove unnecessary information and graphics.

(d) Use contrasting background and text colours.

(e) Use maximum three fonts for the text in a presentation.

(f) Keep the fonts consistent throughout the presentation.

(g) Identify the critical information for your presentation.

(h) Use not more than 6 bullets per page.

(i) Text under bullets should be short ideas, not complete sentences.

(i) Be sure to preview the slide show using a projector if it is required during a presentation.
Words or graphics that are close to the edge of the screen may be cut off by the
projector.

E HTML

Chapter
A. 1. (d); 2. (d); 3.(a); 4. (a)
B. 1. False; 2. True; 3. True; 4. False; 5. True
C. 1. texts; 2. empty; 3. lower; 4. container; 5. BODY
D. 1. The Hypertext Markup Language or HTML is a script that provides a way of organizing the
layout of a web pages and defining the hyperlinks, so that a web page can be linked to other
web page to create a website.
2. The features of HTML are :
(a) HTML provides an attractive appearance to the texts.
(b) HTML can display any kind of document from any host computer anywhere in the world.
(c} HTML links various documents with one another.
(d) HTML is a versatile language suitable for use on such diverse platforms as Macintosh,
Windows, etc.
3. There are two types of HTML tags :

(a) Empty Tags
(b) Container Tags

(a) Empty Tags : Empty tags are stand-alone and do not contain text or any other tag
element. An empty tag function is a standalone element within an HTML document
<BR><Break> is an example of empty tag. <BR>tag simply inserts a line break.
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(b) Container Tags : HTML tags which contain text or bracket or other tag elements are
called container tags. These actually consists of two tags :

A start tag <and an end tag</>which enclose the text.

4. The basic structure of any HTML document is as follows :

Every HTML
document begins > <html>
with the <html> tag. <head> tag encloses
<head> < the head section of
the web page
<title> & </title> tags <title> Title °f the
enclose the title of > web page </title>
the web page. . The </head> tag
</head>« ends the head
<body> section.
Main contents or the
The maln elements to document’s bOdy along With
be displayed on a web other tags go here.
page are enclosed within </body> e
the <body> & </body> tags. " ocument
</html> < ends with the
</html> tag.

5. Some tags contain special attributes. They provide various options for the text contained.
Attributes are within angular brackets. A space is provided within two attributes which are
written one after another.

HTML attributes generally appear as name-value pairs, separated by “=", and are written
within the start tag of an element, after the elements’ name.

For example :

<tag attribute = “value”> (content to be modified by the tag) </tag>

where tag names the HTML element, attribute is the name of the attribute, set to the
provided value.

6. To check your webpage, perform the following steps :
Step-1 : Click on the Start button.
Step-2 : Point to All Programs.
Step-3 : Click on Microsoft Internet Explorer.
Step-4 : Click on the File menu.
Step-5 : Click on the Open Option. The open dialog box appears.
Step-6 : Choose desired html file from the appropriate folder.
Step-7 : Click on the OK button.



Chapter
. (a); 2. (b); 3. (d); 4. (b); 5. (a)

. True; 2. False; 3. True; 4. False; 5. True
. packets; 2. servers; 3. Hub; 4. ports; 5. Router
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Networking

. Computer network is a telecommunication channel using which we can share data with

other computers or devices connected to same network.

. There are several advantages of networking computers.

(a) We can share resources like printers, data, etc. and save money.
(b) We can share a single Internet connection among many computers.

(c} We can communicate through e-mail, chat, videoc conferencing, voice over Internet
Protocol, etc.

(d) We can play games that allow multiple users at different computers.
(e) As all the data is present at one place- the server, so it is easier to back up data.

. A Local Area Network (LAN) is a communication network consisting of many computers

(mostly personal computers) that are placed within a local area, such as inside an office
building or in a school whereas. Wide Area Network (WAN) has connectivity spread over
large geographical areas from country to country. The transmission of data, in general, takes
place through satellites. It’s a bridge that connects remote LANs.

. Computers that are designed or used for networking are called servers.
. Each device is connected individually to a Switch or Hub. It is expensive to install but is most

reliable. If the main cable fails, only one workstation is affected. So, if a workstation is not
working then it will not affect the working of the others since each workstation is directly
connected to the server.

. A Router is like a traffic policeman. It directs network traffic. When we send data through a

network, the data gets divided into tiny packets. All the packets do not take the same path. A
router determines the fastest available path.
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1.
. True; 2. True; 3. False; 4. True; 5. False
. computer; 2. publishing; 3. Apple Safari; 4. Home; 5. files
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(c); 2. (a); 3. (b); 4. (b); 5. (c)

. The internet is a network of networks that consists of milliens of computers spread across

the world.

Brief History of Internet : The Internet started in the 1960s as a way for government
researchers to share information. Computers in the 60s were large and immobile and in
order to make use of information stored in any one computer.



Another catalyst in the formation of the Internet was the heating up of the Cold War. The
Soviet Union’s launch of the Sputnik satellite spurred the U.S. Defense Department to
consider ways through which information could still be disseminated even after a nuclear
attack. This eventually led to the formation of the ARPANET (Advanced Research Projects
Agency Network), the network that ultimately evolved into what we now know as the
Internet. ARPANET was a great success but membership was limited to certain academic and
research organizations who had contracts with the Defense Department. In response to this,
other networks were created to provide information sharing.

January 1, 1983 is considered the official birthday of the Internet.

2. The first thing we need to connect to the Internet is a computer. Cther than the computer,
we also need a few more things :

(a) Modem : A modem relays information between the computer and the Internet.
It converts digital signals to analog and vice-versa.

(b) Telephone Line : The information we send and receive over the Internet travels through
telephone cables.

(c} ISDN Line : ISDN stands for Integrated Services Digital Network. Information that travels
through the ISDN is two to four times faster than through any modem available. Many
telephone companies offer ISDN lines to connect to the Internet.

(d) Internet Service Provider (ISP) : The service provider can be any organization that gives
us the facility for connecting to the Internet. The service provider usually allows the use
of Internet for a change.

(e) Web Browser : A web browser is a software used to access Internet. Microsoft Internet
Explorer, Mozilla Firefox, Netscape Navigator are some commonly used web browsers.

3. A website, also written as web site, or simply site, is a set of related web pages. A website is
hosted on at least one web server, accessible via a network such as the Internet or a private
local area network through an Internet address known as a uniform resource locator.

There are different types of websites :

(a) Personal Websites (b) Photo Sharing Websites

(c} Writer's/Author’s Websites (d) Community Building Websites
(e) Mobile Device Websites (f} Informational Websites

(g) Online Business Brochure/Catalog Websites (h) E-commerce Websites

4. A web browser is the software that we use to access the World Wide Web.
Some popular browsers and brief explanation about them are as follows :

(a) Internet Explorer : Microsoft’s Internet Explorer is one of the most popular browser
today. IE was introduced in 1995,

(b) FireFox : FireFox is a browser form Mozilla. It was released in 2004 and is an extremely
popular browser today.

(c}) Opera : Opera is a fast, small, and standards-compliant web browser. Opera is the
preferred browser for a number of small devices like mobile phones and hand-held
computers.
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(d) Google Chrome : Google Chrome is a free, open-source web browser developed by
Google. It was released in 2008.

(e) Apple Safari: The Safari browser is the default browser for Mac systems.

. A search engine is a software program that searches the World Wide Web for web pages

that contain the keyboards or phrases that we have specified in the search.

. E-Mail stands for Electronic Mail. It is a facility on internet to compose, store, send and

receive messages to any part of the world. The convenience, simplicity and affordability of
sending mails on Internet has totally changed the correspondence system.

. There are numerous advantages of social networking. After every hour or so, people log

onto Facebook, Twitter and post their status update or communicate with friends. People
can set up a profile page displaying information about themselves.

The disadvantages of social networking sites are that some times they are too addictive-
people do not want to leave and keep gossiping with friends.
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Chapter

1.
1.
1.

(d); 2. (b); 3. (a); 4. (c); 5. (b)
True; 2. True; 3. True; 4. False; 5. True
Electronic Commerce; 2. Electronic Data Interchange; 3. Electronic Commerce; 4. customers,

suppliers; 5. trade

1

2.

Electronic commerce means doing business online or selling and buying product and
services through web store fronts.

Carrying out trade and business professions and services are not new facts of human
activities. These were being performed ever since making started living in a group.
Conventional means and ways are generally adopted to pursue these activities.

In the past few decades, the advancement in electronics has brought about facilities of telex,
fax, mobile phone, etc. Further, the development of computers and multimedia systems has
made a dent into the life of mankind and has made considerable impact on their day to day
working. True to the famous proverb “Barax on the gold”, the facility of satellite
communication came as a boom. All these conveniences ushered in a new area of video
conferencing.

Then come to the most fascinating facility of internet which made a mesh of communication
liked throughout the world. Now the global distance have become too short, just a second
away from anywhere. The world wide web interlines huge documents of all kinds and access
to it is available to any one of any time from anywhere. Thus a simple, easy and very quick
system has became available for carrying out trade and business through electronic means.

. There are three kinds of e-commerce :

(a) Business to Business (B2B).
(b) Business to Customers {B2C)
(c} Digital Middleman
11
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Multimedia is a technology of accurate mixing of different elements with the help of
computers.

. To ensure a successful e-business today and in future, the business people, firms and other

related parties must strictly do the following strategies :
(a) High performance and flexible software.

(b) Round the clock working.

(c} System expertise training.

(d) Efficient links with business partners.

(e) Data auditing.

{(f) Security.

‘Model Test Paper-l:

. (b); 2. (b); 3. (a); 4. (d); 5. (a)

. False; 2. False; 3. False; 4. True; 5. False

. barcodes; 2. Status; 3. pictorial; 4. slides; 5. slide

. The modern age is the age in which the electronic machines like computers have been

invented. The computer was not invented by just one person. It was the outcome of a
sequence of a contributicns of many pecple.

The history of computers started in 1939 with Howard Aiken and Mark-I. But it was long
before, when the design of an automatic computer was conceived by an inventor Charles
Babbage, a British mathematician. He is also known as “the father of computers.” This
machine used a different method of computation, so Babbage called the machine difference
engine, but this project was flop. Then Babbage designed another machine, an analytical
engine whose design and features were remarkable and close to the modern computers
with capabilities of storing program, But again this idea could not succeed.

In 1937, Howard Aiken of Harward University designed a machine called Mark-I. Mark-1 was
capable of automatically performing a long sequence of arithmetical and logical operations
and preparing the mathematical tables which was a time consuming and error prone task.
Design of Mark-1 completed in 1944.

. Mail merge is a tool which allows us to creates form letters, mailing labels and envelopes by

linking a main {common) document to a set of data or data source.

. Header : Header is placed at the top of a page of a document.

Footer : The footer is placed at the bottom of the page in the document.

. Charts {graphs) are the pictorial representation of worksheet data. Charts present worksheet

data in graphical or pictorial form, which is easier to read and understand.
Its types are as follows :
(a) Area chart: An area chart emphasizes the magnitude of change over time.

(b) Column Chart : A column chart shows data changes over a period of time or illustrates
comparisons among items.

(c} Bar Chart: A bar chart illustrates comparisons among individual items.

12
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(d) Line Chart : A line chart shows trends in data at equal intervals. Line charts are useful for
depicting the change in a value over a period of time.

(e) Pie Chart : A pie chart shows the proportional size of items that make up a data series to
the sum of the items.

. The Conditional Foermatting option allows us to format cells in a worksheet depending on

whether they meet a prescribed condition or not.

. Animation is the process by which multiple pages are displayed rapidly in a sequence such

that the images appear to be in motion. It is the addition of special visual/sound effects to
the text and graphics on a slide.

Animation can be used for any or all of the following purposes :

(a) To emphasize on important information in the slide.

(k) To control the order in which information is displayed on the slide.
(c} To hold the attention and interest of the audience.

Model Test Paper-ll

. (d); 2. (a); 3. (b); 4. (b); 5. (a)

. True; 2. True; 3. False; 4. True; 5. True

. empty; 2. BODY; 3. ports; 4. files; 5. customers, suppliers
. There are two types of HTML tags :

(a) Empty Tags : Empty tags are stand-alone and do not contain text or any other tag
element. An empty tag function is a standalone element within an HTML document
<BR><Break> is an example of empty tag. <BR>tag simply inserts a line break.

(b) Container Tags : HTML tags which contain text or bracket or other tag elements are
called container tags. These actually consists of two tags :

A start tag <and an end tag</>which enclose the text.

. Some tags contain special attributes. They provide various options for the text contained.

Attributes are within angular brackets. A space is provided within two attributes which are
written one after another.

u_n

HTML attributes generally appear as name-value pairs, separated by “=”, and are written
within the start tag of an element, after the elements’ name.

For example :
<tag attribute = “value”> (content to be modified by the tag) </tag>

where tag names the HTML element, attribute is the name of the attribute, set to the
provided value.

. Computer network is a telecommunication channel using which we can share data with

other computers or devices connected to same network.

4. A web browser is the software that we use to access the World Wide Web.

13



Some popular browsers and a brief explanation about them are as follows :

(a) Internet Explorer : Microsoft’s Internet Explorer is one of the most popular browser
today. IE was introduced in 1995.

(b) FireFox : Firefox is a browser form Mozilla. It was released in 2004 and is an extremely
popular browser today.

(c}) Opera : Opera is a fast, small, and standards-compliant web browser. Opera is the
preferred browser for a number of small devices like mobile phones and hand-held
computers.

(d) Google Chrome : Google Chrome is a free, open-source web browser developed by
Google. It was released in 2008.

(e) Apple Safari: The Safari browser is the default browser for Mac systems.

. Multimedia is a technology of accurate mixing of different elements with the help of
computers.

. Electronic commerce means doing business online or selling and buying product and
services through web store fronts.

14
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Hardware and Software

A. 1. (a);2.(a); 3.(c); 4.(b}; 5. (c)
B. 1. False; 2. True; 3. True; 4. False; 5. True
C. 1. Windows; 2. programming languages; 3. program; 4. Software; 5. operating system
D. 1, Hardware refers to the physical components of a computer such as memory, CPU, transistors,
nuts and bolts, and so on whereas Software represents the set of programs that govern the
operations of a computer system and make the hardware run. For example : SQL, C++
2. A special purpose program is meant to solve a specific problem such as designhing a
component for an industry whereas the general purpose software programs such as
spreadsheet, word processing and database are used to perform a large variety of jobs.
3. The system software is designed to control and co-ordinate the computer hardware, while
the application software is designed to solve a particular problem.
4. A programming language is a formal constructed language designed to communicate
instructions to a machine, particularly a computer.
5. HLL uses simple English words and well known mathematical expressions whereas LLL is
composed of binary digits 0 and 1 only.
6. (a) MS-DOS : MS-DOS is the oldest system. It is primarily used to IBM compatible, single

user computers. It has a command line interface that appears difficult to learn and use.

(b) MS-Windows : Windows is more easy to use, reliable, entertaining and fast. With it the
files can be operated with a single click, and also the multiple monitors can be used with
a single computer. Connection to the web is simple and web pages can be created using
front page.

(c} Linux : Linux is an operating system for computers. It is a recent technology and is
getting world wide popularity. It is more effective for computer networks. Contrary to
other operating system, it is provided with a source code.

2

Chapter_
1.

1.
1.
1.
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Computer Security

(b); 2. {c); 3. (a); 4. (b); 5. (a)
True; 2. True; 3. True; 4. False; 5. False
hard disk; 2. challenge; 3. Stealth; 4. firewall; 5. cracker

A computer virus is a program written to alter the way a computer operates, without the
permission or knowledge of the user.

Viruses are activated on computer in three basic ways :

(a) opening an infected file

(b) running an infected program

(c} booting the computer with an infected floppy disk in the disk drive
15



The most common way of virus in a computer is through the attachment in e-mail. Before
we open or execute any e-mail attachment, we should ensure that the e-mail message is
from a trusted source.

Viruses in computer are not generated accidentally but are programmed intentionally by a
programmer known as a virus author.

. Stealth Virus : This type of virus attempts to hide its presence. Some of the simple

techniques include hiding the change in date and time and hiding the increase in the file size.
Some even prevent anti-virus software from reading the part of the file where the virus is
located.

Multipartite Virus : This virus can infect both the boot sector of a disk as well as the
executable files. It is the worst virus because it can combine a lot of techniques to prevent its
detection.

. Firewall is a network security system that controls the incoming and outgoing network traffic

based on an applied rule set. A firewall establishes a barrier between a trusted, secure
internal network and another network {e.g., the Internet) that is assumed not to be secure
and trusted.

Firewalls are frequently used to prevent unauthorized Internet users from accessing private
networks connected to the Internet, especially “intranets”.

. Computer ethics is a set of moral principles that regulate the use of computers.
. Hackers typically break into a computer by connecting to it and then logging in as a

legitimate user. A cracker is someone who tries to access a computer or network illegally.

. Cyber law is a term used to describe the legal issues related to use of communications

technology, particularly “cyberspace”, i.e. the Internet.

3

HTML

Chapter
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1.
1

1
1

(b); 2. (a); 3. (d); 4. (c); 5. (a)
True; 2. False; 3. True; 4. True; 5. False

. header; 2. two; 3. attribute; 4. <Font>; 5. web page
. HTML stands for Hypertext Markup Language. It is used to create web pages. Web pages are

text documents. HTML is a language where ordinary text can be converted into hypertext.

. The header tags are used in HTML documents to display headings. Header tags are used to

manipulate the size of the headings, i.e. they make your heading larger or smaller according
to the tag used.

. It gives us a way to separate sections of our document visually. The <HR> tag is an empty tag

and provides a horizontal line spread across the width of the browser window. We can set
two attributes of horizontal rule : rule size {thickness) and width (% of window covered by
the line).

Syntax : <HR> or <HR size = “value” width = “value”>
Example : <HR size = 4 width = 40%>

16
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Comments are one of the textual content which appear in the document but are not
recognized by the browser. Comments are given between the braces as shown in the
example.

Example : <!....This is a comment...>
<l.... This is a program
which will be used as a multiline comment ....>

. The different attributes of font tag are :
(a) FONT FACE : This element is used to change the typeface or name of the font.
Syntax :  <FONT FACE= “Name of the Font”> text </FONT>
Example i <FONT FACE= “VARDANA”> EDUCATION</FONT>
(b) FONTSIZE :  This element is used to change the size of the text.
Syntax : <FONT SIZE= “Size”> </FONT>
Example . <FONT SIZE = “4”"></FONT>

We can specify a font size from 1 to 7. The smallest font size is 1 and the largest font size is 7.
(c} FONT COLOR : This element is used to change the colour of the text. The colour can
be set by specifying the name of the colour or by giving colour codes.
Syntax ¢ <FONT COLOR= “Name or code of colour”></FONT>
Example :  <FONT COLOR = “Red”></FONT>

. To see how the web page looks like, follow the steps 1 to 4 as follows.

Step-1 : Open the browser software for example Internet Explorer.
Step-2 : Choose File > Open.

Step-3 : Locate the web page that we want to see.

Step-4 : Click Open.

The HTML file opens within the browser as a web page.

4

More About HTML

Chapter |

A. 1. (c}; 2.(b); 3.(c); 4. (a); 5. (b)

B. 1. True; 2. True; 3. True; 4. False; 5. False

C. 1. <DIR>; 2. TYPE; 3. START; 4. URL; 5. Visited

D. 1. The five main types of lists supported by HTML are given below :
(a) Unordered lists (b) Menu lists
(c} Directory lists (d) Ordered lists

(e) Definition lists
(a) Unordered Lists : An unordered list is used when the items are not to be displayed in any
particular order. The list begins and ends with <UL> and </UL> tags respectively.

(b) Menu Lists : Menu list allows us to create a list in which each element is a word or a
phrase that fits in a single line. It appears in more compact way than the other lists. This
tag is mostly used for linking with other documents or images.

(c} Directory Lists : Directory list can be created by <DIR> container tags. This is normally
used for list of file names of some bills.

17



(d) Definition Lists : A definition list is an indented list of terms and definitions. Entries in a
Definition list do not have any bullet or number in front of them. Tags that are used for
creating a definition lists are given below :

<DL>tag : Creates a definition list
<DT>tag : Defines a definition term

<DD> tag : Used to give the description or definition of the term mentioned with the
<DT> tag

Syntax : <DL><DT>term 1 <DD> Definition
<DT> term 2 <DD> Definition </DL>
(e) Ordered Lists : Ordered list is used to display the list of items in a specific order. By
default numbers are displayed in a web browser when an ordered list is used. We can
change the style using the “TYPE” attribute. To specify the item number for a given list

item ‘Value’ attribute is used. Ordered list automatically starts with value 1 but you can
start a list with a different number.

. The <IMG> tag is used for, to insert image in web page. Its attributes are :

Attribute Description

SRC “SRC" specify the source of the image i.e it tells us about the image.
The value of the SRC attribute is the URL of the image you want to
display on your page.

Alt The alt attribute is used to define an “alternate text” for an image.
The value of the alt attribute is an author-defined text.

Height and width To define the height and width of the image, rather than letting the
hrowser compute the size, use the height and width attributes with
image tag.

Align To align the picture or image in a web page use left, top, middle, right
and bottom values with align attribute.

Border To specify the border around the image use border attribute. The
possible values are 1, 2, 3 and so on.

. The <table> tag alongwith the <tr>, <th> and <td> tags is used for creating the various
components of a table. The following figure shows how these tags are used for creating a

table :
Every table that we create in —» <table> The <th> tag is used within the
HTML begins and ends with > <tr><th>1st column header</th> «— <tr> tag and creates a header cell
the <table>... <ftable> tag. <th>2nd column header</th> of the table. It encloses the data
........................................... </ftr> that is there in a header cell.

The <tr> tag creates a new row
in the table. All the tags that <td> 2nd data cell value </td>

are used for creating the data L[ st s i e s
and header cells are enclosed

within the <tr>..</tr> tag.

...... <th> header cell data </th>

<tr> <td> 1st data cell value </td> The <td> tag I alko nsed within

<4— the <tr> tag and creates a data
cell of the table. It encloses the
data that is to appear in a data
cell <td> data in the cell </td>

</table>
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4. A hyperlink is a piece of text or an image which is linked to another web page. So, if we click
on it the page to which it is linked opens up. The most common type of hyperlink is the text
hyperlink that appears underlined on a web page and is usually in a different color.

5. There are mainly two types of links that can be created in HTML ;

(i) Hyperlinks to other pages within the current/other website. This is called External
linking. External linking involves connecting two different web pages.

(i) Hyperlinks anchors/bookmarks on the same page. A point on a page is bookmarked so
that we can have a hyperlink which when pressed takes to the bookmark, This is called
Internal Linking. Internal linking involves linking parts of the same page.

E Introduction of Photoshop

Chapter

oCNnwp

1. (c}; 2. (b); 3. (b}; 4. (c); 5. (b)
1. True; 2. False; 3. True; 4. True; 5. False
1. tool; 2. drawing; 3. window; 4. layers palette; 5. contents

1. Photoshop is a popular image changing software package. It is widely used by photographers
for photo editing.

2. The various tools of the Photoshop toolbox are :
(a) Move tool (V) (b) Marquees selection tools (M)
(c} Lasso tools (L) (d) Quick selection/Magic wand (W)
(e) Crop tool (C)/Slice/Slice select tool (K)
(f) Eyedropper/Color sampler/Measure/Count (1)
(g) Spot Healing/Healing brush/Patch tool/Red eye tool
(h) Brush tool/Pencil/Color replacement tool {B) (i) Clone stamp/Pattern stamp (S)

(i} History/Art History brush (Y) (k) Eraser/Background/Magic Eraser (E)
() Paint Bucket/Gradient (G) (m) Blur/Sharpen/Smudge (R)

(n) Dodge/Burn/Sponge (0) (o} Pen path tools (P}

(p) Type tools/Type mask tools (T) (g) Path Selection/Direct Selection (A)
(r) Shape tools (U) (s) Hand tool (H)+Rotate View Tool

(t) Zoom tool {Z) (u) Exchange colors (X)

(v} Foreground color (w) Background color

3. When we save an Adobe Photoshop file, it is by default saved as a PSD file. This is the native
file format of Photoshop. The Save As command allows us to choose from nearly twenty
different file formats for image.

Step-1 : Click on File menu.

Step-2 : Click on Save As or press Shift+Ctrl+S
Step-3 : Select any file format.

Step-4 : Click on Save.
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The Layers Pallette lists all the layers, layer sets, and layer effects in an image. We can
accomplish many tasks— such as creating, hiding, displaying, copying, and deleting layers—
using the buttons in the Layers pallette.

. The steps to select a layer are as follows :

(a) Open the layers pallette and click on the icon of the layer we want to work with.

(b) The layer will get selected and its name will appear on the title bar. A paint brushPicon
will appear against the selected layer in the layers pallette, also indicating that this layer
is currently active,

(c} We can now resize, move, erase or delete the layer (image) as required using the
appropriate tools. Any changes we make will be applied to the selected layer only and
would not affect the other layers.

.We can add new layers using the Layers pallette by following the steps given

below :
Step-1: Select the layer above which we want to insert a new layer.
Step-2 : Click on the Create a new Layer button on the Layers pallette.

Step-3 : A new layer will get inserted above the selected layer in the image as well as in the
layers pallette.

. Follow the steps to lock a layer :

1. Select the layer, which we want to lock, from the Layers pallette.

2a. Click Lock transparent pixels icon to lock the transparent pixels in the layer. To unlock the
layer we click at it again.

2b. Click Lock All icon to lock all the contents of the layer. To unlock the layer click at it again.

2¢. Click Lock position icon to lock position in the layer in the image. To unlock the layer click
at it again.

2d. Click Lock image pixels icon to lock the pixels that form the image. To unlock the layer
click at it again.

When all the contents of a layer are locked, a lock icon () displays to the right of the layer
name.

6

Chapter_
1.

1,
1.
1.

oOnNnwp»

More In Adobe Photoshop

(d); 2. (b); 3. (a); 4. (b); 5. (c)

False; 2, False; 3. True; 4, True; 5. True

Marquee; 2. Color Sampler; 3. notes; 4. Dodge; 5. Smudge

The steps to crop an image are :

Step-1 : Click on the Crop tool.

Step-2 : Click and drag to select the area of the image we want to keep.

Step-3 : We can click and drag the sides and corner handles to adjust the size of the cropping
boundary.
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Step-4 : Click on the right button or press the Enter key on the keyboard.
Press Esc button on the keyboard to exit from the cropping process.
Photoshop crops the image, deleting the pixels outside the cropping boundary.

. The Slice tool allows us to divide an image into smaller sections which fit together like a
jigsaw (but with straight edges). The slice tool is located in the top section of the photoshop
Toolbox.

The steps to use the Slice and Slice Select tools are :
Step-1: Select the Slice tool in the toolbox.
Step-2 : Click and drag over the area we wish to make into a slice.

Step-3 : Release the mouse button, photoshop automatically creates the necessary number
of slices, with the active slice highlighted.

Step-4 : Using the Slice Select tool, we can move and resize slices by dragging inside a slice,
or by dragging the handles.

. The Eyedropper tool is used to pick up a color value from the canvas. This is a very useful
tool because there will be many times when you want to switch colours while painting to a
colour already on our canvas and we do not want to go all the way through the color
chooser dialog.

. The Ruler tool helps us positicn images or elements precisely. The Ruler tool calculates the
distance between any two points in the workspace. When we measure from one point to
another, a nonprinting line is drawn, and the options bar and info panel show the following
information :

% The starting location (x and y)

The horizontal (W) and vertical (H) distances travelled from the x and y axes
The angle measured relative to the axis (A)

The total length travelled (D1)

The two lengths travelled (D1 and D2}, when we use a protractor.

® ¢ o %

To measure hetween two points, follow the given steps :
Step-1: Select the Ruler tool. (If the Ruler isn’t visible, hold down the Eyedropper tool.}

Step-2 : Drag from the starting point to the ending point. Hold down the Shift key to
constrain the tool to 45° increments.

Step-3: To create a protractor from an existing measuring line, Alt-drag (Windows) or
Option-drag (Mac OS) at an angle from one end of the measuring line, or double-
click the line and drag. Hold down the Shift key to constrain the tool to multiples of
45°,

. Its main use is in areas such as scientific and medical imaging, where it is useful for recording

the number of items that appear in a particular image.

. The Retouching tools available in Photoshop are used for modifying the arrangement of
pixels in an image to remove imperfections from the image and give it a better finish.

. It is useful for removing red eye from photographs that have been taken with a direct flash
source.
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8.

Dodge Tool lightens the pixels where we paint and the Burn Tool darken the pixels where we
paint. They are known as toning tools. They work in the similar manner as the traditional
photography where, in the darkroom, light could be blocked out (dodged) in order to make
portions of an image lighter, or light could be passed through a small concentrated hole to
darken (burn) an area. We can toggle between both the tools by pressing Shift + 0. While
sponge tool is used to saturate or desaturate a certain area on a picture and so it is related
to Dodge and Burn tools.

7

Introduction To QBasic

Chapter
A. 1. (a);2.(b); 3.(c); 4. (b); 5. (a); 6. {(c)
B. 1. False; 2. False; 3. False; 4. True; 5. True
C. 1. Basic language; 2. Arithmetic operation; 3. Variable; 4. Input; 5. CLS
D. 1. Input statement; 2. Let statement; 3. Print statement; 4. REN statement; 5. FOR...NEXT LOOP
E. 1. QBasic a short form of ‘Quick Beginners All Purpose Symbolic Instruction Code’ is a
integrated development environment and interpreter for a variety of Basic programming
languages which are based on Quick Basic. QBasic is a simple way to write programs and
create different figures.
2. Arithmetic operator
Operator Arithmetic Symbol Example
Addition + X+y
Subtraction - X—y
Multiplication * Xx*y
Division i x/y
Exponential A XMy
Parentheses () X+(y*z)
Relational Operator
Operator Relational| Function Example Let| Output
Symbol x=2,y=3
Equal to = To check equality between two or X=y False
more values
Notequalto |<> To check if the two or more values | x<>y True
are not equal
Greater then | > To check if the first value is greater | x>y False
then the second values
Less than < To check if the first value is smaller | x<y True
than the second value
Greaterthan | >= To check if the first value is greater | x>=y False
or equal to than or equal to the second value
Lessthanor |<= To check if the first value is less X<=y True
equal to than or equal to the second value
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Logical Operator

Operator | What it means

AND If both the operand conditions are true, then the final result must be true,
otherwise false.
OR If at least on of the operand conditions is true, then the final result must be true

otherwise false.

NOT It negates the result of condition.

O

. An expression refers to a combination of constants and variables along with operators in a

particular format that is evaluated to obtain the desired result. The result that we get can be
in the form of string, numeric or logical value. (True or False}. The result can be stored in a
variable,

. Let statements : The Let Command is used to assign a numeric or string constant to

variables. However the use of word LET is optional.

Syntax : Let [Variable name] = [constant]

Input Statement : The INPUT command takes data from the uses of a program during its
execution. The user gives the data are assigned to a variable. A question mark (?} also
appears on the screen.

Syntax : INPUT variable name

. IF....THEN Statement : This statement tests a particular condition and returns an answer as

true or false. If the condition is true, the computer will follow the command given after
THEN. If the condition is false, the computer will altogether ignore the command after THEN
and move to the next line. This statement is used when a decision is to be made.

Syntax : IF [condition] THEN [command]

IF...THEN...ELSE Statement : Then IF...THEN...ELSE statement tests a particular condition and
asks the computer true or false questions only. If the condition is true, the computer will
follow the command given after THEN. If the condition is false, the computer will altogether
ignore the command after THEN and move to the ELSE part to execute the command stated
there.

Syntax : IF [condition] THEN [command] ELSE [command]

. (e} 2. (¢); 3. (c); 4. {c); 5. (b)

. True; 2. True; 3. False; 4. False; 5. True

. Software; 2. firewall; 3. header; 4. <FONT>; 5. URL

. The system software is designed to control and co-ordinate the computer hardware, while

the application software is designed to solve a particular problem.

. Firewall is a network security system that controls the incoming and outgoing network traffic

based on an applied rule set. A firewall establishes a barrier between a trusted, secure
internal network and another network {e.g., the Internet) that is assumed not to be secure
and trusted.
Firewalls are frequently used to prevent unauthorized Internet users from accessing private
networks connected to the Internet, especially “intranets”.
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. Hackers typically break into a computer by connecting to it and then logging in as a
legitimate user. A cracker is someone who tries to access a computer or network illegally.
. Comments are one of the textual content which appear in the document but are not
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. (c}; 2. (b); 3. {c); 4. (c); 5. (b)
. False; 2. False; 3. True; 4. True; 5. True
. layers pallette; 2. Marquee; 3. Dodge; 4. brush; 5, paint bucket

. Photoshop is a popular image changing software package. It is widely used by photographers
for photo editing.

The Layers Pallette lists all the layers, layer sets, and layer effects in an image. We can
accomplish many tasks— such as creating, hiding, displaying, copying, and deleting layers—
using the buttons in the Layers pallette.

. The Slice tool allows us to divide an image into smaller sections which fit together like a
jigsaw (but with straight edges). The slice tool is located in the top section of the photoshop
Toolbox.

The steps to use the Slice and Slice Select tools are :
Step-1: Select the Slice tool in the toolbox.
Step-2 : Click and drag over the area we wish to make into a slice.

Step-3 : Release the mouse button, photoshop automatically creates the necessary number
of slices, with the active slice highlighted.

Step-4 : Using the Slice Select tool, we can move and resize slices by dragging inside a slice,
or by dragging the handles.
. The Retouching tools available in Photoshop are used for modifying the arrangement of
pixels in an image to remove imperfections from the image and give it a better finish.

. It is useful for removing red eye from photographs that have been taken with a direct flash
source.
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Operating System

Chapter
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(b); 2. {c); 3. {c); 4. (d); 5. (a)
True; 2. True; 3. False; 4. True; 5. False
operating system; 2. graphical; 3. UNIX; 4. Keyboard; 5. utility

An operating system is a set of programs that contain instructions for coordinating all the
activities among computer hardware resources.

. {a) Mac OS : It is a series of graphical user interface-based operating systems developed by

Apple Inc. for their Macintosh line of computer systems. The Macintosh user experience
is credited with popularizing the graphical user interface.

(b) Linux : It is a UNIX-based operating system that is available for free on the World Wide
Web. It can be copied, modified and redistributed with few restrictions. This flexibility is
one of the reasons why Linux is so popular among users.

CLl GUI

(a) It is the user interface in which user | (a)} It is the user interface in which user
has to interact with the application by interact through the application by
making use of the commands. making uses of graphics.

(b) The command is usually typed on a | (b) The users selects icons and menus with
keyboard. the help of any pointing device,

. Operating Systems perform the following important functions :

(a) Processor Management : It means assigning processor to different tasks which has to be
performed by the computer system.

(b) Memory Management : It means allocation of main memory and secondary storage
areas to the system programmes, as well as user programmes and data.

(c} Input and Output Management : It means coordination and assignment of the different
input and output devices while one or more programmes are being executed.

(d) File System Management : Operating System is also responsible for maintenance of a
file system, in which the users are allowed to create, delete and move files.

(e) Establishment and Enforcement of a Priority System : It means the operating system
determines and maintains the order in which jobs are to be executed in the computer
system,

. It is a type of system software that performs a specific task, usually related to manage a

computer, its devices or its programs. It is also called a utility.
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Introduction to Windows 8

Chapter
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. (c}; 2. (b); 3. (d); 4. (d); 5. (d)

. True; 2. True; 3. False; 4. False; 5. True

. Windows Defender; 2. Windows 8 RT; 3. Logo + Q; 4. multimedia; 5. “shut down”, “sleep”

. Windows 8 is the consumer version of windows 8 that excludes a lot of the business type

feature like drive encryption group policy and virtualization.

. Some of the features of Windows 8 are given below :

(a) The major difference between other versions of Windows 0S and Windows 8 is that
there is no Start button. The Start button provides control to launch applications, access
settings or search the computer. In Windows 8, you have tiles for various applications
instead of Start button.

(b) It has built-in antivirus program called Windows Defender, which can also protect our
computer from other types of malware such as spyware.

(c} These days many people save their files and other data online (known as cloud).

. {(a) Windows Defender : Windows Defender provides antivirus and malware protection to

our computer. In addition to scanning our computer for potentially harmful applications,
Windows Defender also provides real-time protection, double-checking each file or
application we open without slowing down our computer.

(b) Windows SmartScreen : Whenever our computer detects a security threat from a file
or application, Windows SmartScreen will notify us with a full-screen warning.

Alt + F4,

To turn off our PC, open the Charms sidebar and click or tap the “Settings” Charm. Then,
click or touch the “Power” icon.

Click on Power in the Setup menu to shut down.
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Number System

(c}; 2. (d); 3. (b); 4. (a); 5. (b)

True; 2. False; 3. True; 4. True; 5. True

byte; 2. Data, instructions; 3. 10 symbols; 4.0, 1
Number system consists of :

% A set of symbols used for formation of numbers.

% A set of rules which may be used to form number. From these symbols, we assign values
to them.

¢ A set of rules for performing common arithmetic operations are on this system.
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2. The binary number system uses only two symbols 0 and 1. That is why this is called binary

because bi means two. Since, only two symbols are used in the binary number system, the
base of this number system, is 2.

3, The processor of computer performs arithmetic operation only on binary numbers are

known as binary arithmetic.

For example : Add 110 and 100
110
+100
1010

4. (i) Octal Number System : Octal number system is the number system with base 8. This

means in this number system, there are 8 symbols or digits which are used for the
formation of the numbers. These symbols are 0, 1, 2, 3, 4, 5, 6 and 7. Here, place values
are the powers of 8.

(ii) Hexa Decimal Number System : In this system, the base is 16, when the base is two, we
use 2 digits, i.e, 0 and 1. In hexadecimal system, we use sixteen digits instead of two.
These digits are 0, 1, 2, 3,4,5,6,7,8,9,A,B,C,D,E, F, G.

The following table represents the alphabets :
A 10

11

12

13

14

15

16

4

Algorithm, Program and Flowchart

Chapter
A. 1. (b); 2. (a); 3. (b); 4. (b); 5. (a)
B. 1. True; 2. True; 3. True; 4. False; 5. True
C. 1. instruction; 2. program; 3. flowchart; 4. flowlines; 5. Decision
D. 1. An algorithm is a formal set of instructions that can be followed to perform a specific task.
2, Program is a set of series of instructions written in any computer programming high level

w

4

language that are fed into the computer through an input device to perform a certain task.
. A flowchart can be defined as a diagrammatic or pictorial representation of the solution of
any problem.
. A rectangular box represent in flowchart display the processing part.
. The instructions must be remembered in the making of a flowchart are :
(a) Always begin the flowchart with start symbol.
(b) Do not forget to mark arrows on the flowchart to show the direction of flow of
information.
(c} Use appropriate symbols for each step in the flowchart.
(d) Mark the end of flowchart with stop symbol.
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5

Introduction To MS-Access

A. 1. (b); 2.(c); 3. (c); 4. (c); 5. (b); 6. {b); 7. {a); 8. (c); 9. (b)
B. 1. False; 2. False; 3. True; 4. False; 5. True
C. 1. memo; 2. cirrus; 3. table; 4. single file
D. 1. Microsoft Access 2010 provides the following ways to create a database.
4 Creating a blank database. ¢ Creating a database using a template.
@ Creating a database by downloading a template.
2. Manipulation means to make changes in the data. The following modifications can be done
on a table in Microsoft Access :
Add a new record/row : To add a new record, place the cursor at the last value of the last
field/column and simply press the Tab key.
Add a new field/column : To add a new column, right-click on the column header and
choose the Insert Field option. A new field is inserted to the left of selected field.
Update a record : To update or modify a record, simply click in the cell you want to update
and type the new value.
Delete a row/column : To delete a particular row/column, select the entire record or entire
column by clicking on the row header or column header and press the Delete key or right-
click the mouse and select the Delete Record or Delete Field option. Click Yes to confirm.
3. Some advantages of database are :
¢ easy retrieval of data < reduction of data redundancy
% reduction of data inconsistency % easy sharing of data
< easy manipulation of data < high data security
4. Table : A table is a part of the database where the actual data is stored.
Record : MS Access stores the related entries in its row. This row is called a record.
Field : Each type of detail in a record is stored in its columns known as fields.
Query : A query is used to extract information from a database.
5. Datasheet View | | Design View .|
It displays the view in a row/column format | It displays the view which allows you to
which allows you to view, enter or|enter field names, data types and the
manipulate data. description into your table.
6. A primary key refers to one or more fields which uniquely identify each record in a table. A
primary key is used to related a table to foreign keys in other tables.
7. Text : The data type Text contains letters, numbers and symbols. The numbers in a text field

are considered as text and cannot be used for calculation. The length of the text field varies.
It can contain a combination of upto 255 characters.

For example : Aman, Vital3 and A258297T.

Number : The data type Number contains numeric values, It does not accept letters or other
symbols except numbers. For example: 46, 2004, 1989 and 12345.
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Currency : The data type Currency contains symbols for currency, decimals and commas
wherever needed. For example : *100.45, $45 and €20.

. In design view, you have to first create the table’s structure.

To create a table using design view, follow the given steps :
Step 1 : Click the Create tab on the Ribbon.

Step 2 : Click the Table Design | | from the Tables group.

anie
| Cresign

A new table in design view opens up.
Let us create the table structure.

Step 3 : Type the name of a field in the Field Name column and press the Tab key to move
to the Data Type column.

Step 4 : An arrow|-| appears for the drop down list in the Data Type column. Click the arrow
and select the data type according to your field name from the list.

Step 5 : Press Tab key to move to the Description column and type a description of the
field. The description of the field is optional.

Step 6 : Save the table after adding all your fields by clicking the Save button on the Quick
Access Toolbar. The Save As dialog box appears.

Step 7 : Type the table name and click the OK button.
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Fun With Photoshop

(b); 2. (d); 3. (a); 4. (c); 5. (a)
True; 2. True; 3. False; 4. False; 5. True

. right; 2. gradient 3. options; 4. Anchors; 5. Delete
. The features of Adobe Photoshop are :

(a) It contains a large variety of image editing features, one of its most powerful capabilities
is Filters.

(b) Photoshop creates sophisticated images for both print and the Web.

(c} We can use Photoshop’s Paintbrush, Airbrush and Pencil tools to apply colors or patterns
to our images after selecting its pixels. We can also fill the arrows of our selections with
solid or semitransparent colours.

(d) We can brighten, darken and change the hue (shade) of colours in parts of our image
with Photoshop’s Dodge, Burn and similar tools.

. When we use the standard Pen tool, the following options are available in the options bar :

(a) Auto Add/ Delete, which lets us to add an anchor point when we click a line segment or
delete an anchor point when we click it.

(b) Rubber Band, which lets us preview path segments as we move the pointer between
clicks. (To access this option, click the pop-up menu to the right of the Custom Shape
icon.)

. Add Anchor Point Tool : The Add Anchor Point tool adds anchors and reshapes existing

vector shapes/paths (shape outlines).
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Delete Anchor Point Tool : The Delete Anchor Point tocl removes anchor points from vector
lines.

. There are four different types of Type Tools
T Horizontal Type Tool T
IT Vertical Type Tool T

T Horizontal Type Mask Tool T
IT Vertical Type Mask Tool T

. The steps to copy and paste a selection in photoshop are :

Using the Keyboard and Mouse :

(a) Make a selection with a selection tool.

(b) Click a move tool B4.

(c} Press Alt key from keyboard while we click and drag the selection.

(d) Release the mouse button to drop the selection.

A duplicate of the selection is created and appears in the new location.

Using the Copy and Paste Command :

(a) Make a selection with a selection tool.

(b) Click on Edit menu. The Edit menu will appear.

(c} Click on Copy.

(d) With the selection tool, select the area where we want the copy element to be pasted.
If we do not select an area, Photoshop pastes the copy over the original.

(e) Click on Edit menu. The Edit menu will appear.

(f) Click on Paste.

Photoshop pastes the copy into new layer. We can now move it independently on the
original image.

. The various formats to save a file in Photoshop are given below :

¢ We can save a file in the JPEG (loint Photographic Experts Group) format and publish it
on the Web. JPEG is the preferred file format for saving photographic image.

< We can save a file in the GIF (Graphics Interchange Format) and publish it on the Web.
GIF format is good for saving illustrations that have a lot of solid color.
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1.
1.
1.

(a); 2. (b); 3. (b); 4. (c); 5. (b)
True; 2. True; 3. False; 4. False; 5. True
Object Oriented Programming Languages; 2. Abstract Window ToolKit; 3. different;

4. internet; 5. applet

1.

2.

OOP programming is event driven. An event is a message that causes a sub-program {or
procedure) attached to the object to respond.

It is programming language in which we can write code in the form of classes something
similar to classic C++ language. Java is also a platform independent language.
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3. Java has a profound effect on internet. It is because Java expands the universe of those
objects that can move almost freely in cyberspace. In a network, the transmission of passive
information and active programs are quite common between the server and one’s own PC.
Such dynamic programs can be very conveniently run on Java.

Java provides a high level security against risk of viral infection and malicious programs, that
can gather private information such as credit card number, bank balances, and passwords
etc. This security is assumed by means of a firewall provided between network application
and the computer of the business concern.

4, The features of Java are :

It is portable.

It is architecture neutral,

It is dynamic.

It is object oriented.

It can be interpreted on any system.

C++

¢ C++ is basically C with Object-oriented

extension.

C++ supports operator cverlcading.

It supports goto statement.

C++ has template classes.

Source code can be written to be
platform independent and written to
take advantage of platform. C++
typically compiled into machine code.

Introduction to Flash

(a) Itis simple. (b)
(¢} Itis robust. (d)
(e) It has high performance. )
(g) Itis secure. (h)
(i) Itis multi-threaded. )]
(k) It is designed for distributed environment of the Internet.
5. Java
¢ Java is true object-oriented language.
% Java does not support operator
overloading.
¢ It supports labels with loops and
statement blocks.
% Java does not have template classes as
in C++,
¢ Java compiled into byte code for the
Java Virtual Machine. The source code
is independent on operating system.
8
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1. (b); 2. (c); 3. (b}

1. True; 2. True; 3. False; 4. True; 5. False
1. Timeline Panel; 2. Pencil Tool; 3. Grouping; 4. Fill Color

1. Adobe Flash Professional CS6 is a software used for creating animations, games, cartoons,

text, graphics and other special effects. It also helps to design ‘movies’ on the web and
create animations without using programming skills.

2. To create a new Flash file, click the Actionscript 3.0 option from the create new option list.
3. Line Tool is used to draw lines on the stage. Pencil Tool is used to draw free-from lines. The
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4,

Pain Bucket Tool is used to fill an object with colour.

To use the Paint Bucket Tool, follow the given steps :

Step 1 : Draw the shape and click the Paint Bucket Tool <% on the tools panel.

Step 2 : Choose a colour from the Fill color under the FILL AND STROKE section in the
Property Inspector.

Step 3 : Click on the shape you want to fill with colour. The shape gets filled with the
choosen colour.

. Grouping means to combine to basic shapes/cbjects together as one. For example, to design

a car, we use various shapes. However, all these shapes need to be grouped as one for the
complete car to be formed.

To group objects, follow the given steps :

Step 1 : Draw the shapes and select all of them using Selection Tool [ % |.

Step 2 : Click the Modify menu and then click Group option.

To ungroup the objects, select an object that is grouped together and click the Modify menu
and then click the Ungroup option.

. The Adobe Flash Professional CS6 interface has the following components :

Menu Bar gives access to all the commands available in Flash.

Stage is the white rectangular area where your work is displayed.

Work area refers to the light grey area around the Stage. You can place objects here until you
want them to appear on the Stage.

Property Inspector is used to organise and modify the properties of the current selection.
Timeline Panel organises and controls a file content over time in layers and frames.

Tools Panel is used to choose different tools.

Color Palette is used to choose different colours.
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Online Commerce Strategies and Solution

(a); 2. (a); 3. (c); 4. (a); 5. (b)
True; 2. True; 3. False; 4. True; 5. False
Internet; 2. Online; 3. Hypertext Markup Language; 4. Structural Query Language; 5. Internet

Service Provider

D. 1.

Online commerce is the buying and selling of goods and services, or the transmitting of
funds or data, over an electronic network, primarily internet.

. The concept to be on the Internet (line), means having a place on the web. And this is the

place where information relating to a particular person or organization are stored and can be
located or searched. This concept is also termed as “on the web” on the internet or online
presence.

. To create a specified kind of customization an understanding of following languages is also

required :
(a) Hypertext Markup Language (HTML) (b) Graphical Software Package
(¢} Structural Query Language {SQL) (d) DB2 Universal Database.

(e) C++ Programing Language
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. Some online solutions are :

(a) e-interviews (b) e-classroom teaching
(c} e-job advertising (d) e-information service
(e) e-selling

. Medical transcription is an allied health profession, which deals in the process of

transcription, or converting voice recording reports as dictated by physicians or other
healthcare professionals, into text format.

. An Internet Service Provider (ISP) provides an access to the internet. It also provides an

account number to the user for searching.

. Call centre is a new dimension in online business that provides services and informations to

its customers anywhere in the world.
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(b); 2. (c); 3. (d); 4. (a); 5. (d)

. True; 2. False; 3. False; 4. True; 5. False
. Office Automation; 2. electronic; 3. Word processing; 4. e-calendering; 5. Video conferencing
. Office Automation refers tc such a system that facilitates a firm to communicate with people

both inside and outside the firm.

. Word processing is used to preparing letters, memos and reports etc. in respect of written

communication.

. Voice mail system send message by speaking over the telephone rather than by typing them

as in e-mail.

. The process of preparing a calender by electronic means is known as e-calendering. The

calender may be meant for the purpose of recording/noting the appointments like
scheduled meetings, important tasks to be performed, an outside visit etc.

. It refers to a voice communication is which an audio like is established between two persons

situated far-off from each other. Audio conferencing does not require a computer, rather
needs a two way audio communication facility.

. (a) Video conferencing is an expensive method, while desktop video conferencing is a

comparatively cheaper mode of video conferencing.

(b) Video conferencing does not need any computer, while in desktop video conferencing, a
desktop is needed.

. Office automation technclogy has given birth to a new concept virtual office (VO). Such

office has become possible due to advancements in data communication methodologies.
Ideo of vo envisages that certain workers (telecommuters) of a firm may perform some or all
of their work anywhere in firms premises or at home. Whole working at their home, such
workers communicate with their offices {(corporate office, divisional office, branch office
etc.) by means of electronic systems.

Virtual office may be either located permanently or temporarily, and is electronically linked
to the firms fixed location.
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. graphical; 2. “shut down”,

(d); 2. (d); 3. (b); 4. (b); 5. (b)

. True; 2. True; 3. True; 4. True; 5. False

P

sleep”; 3. 10 symbols; 4. Flow lines; 5. Macros

. Operating systems perform the following important functions :

(a) Processor Management : It means assigning processor to different tasks which has to be
performed by the computer system.

(b) Memory Management : It means allocation of main memory and secondary storage
areas to the system programmes, as well as user programmes and data.

(c} Input and Output Management : It means coordination and assignment of the different
input and output devices while one or more programmes are being executed.

(d) File System Management : Operating System is also responsible for maintenance of a
file system, in which the users are allowed to create, delete and move files.

(e) Establishment and Enforcement of a Priority System : It means the operating system
determines and maintains the order in which jobs are to be executed in the computer
system.

. (a) Windows Defender : Windows Defender provides antivirus and malware protection to

our computer. In addition to scanning our computer for potentially harmful applications,
Windows Defender also provides real-time protection, double-checking each file or
application we open without slowing down our computer.

(b) Windows SmartScreen : Whenever our computer detects a security threat from a file or
application, Windows SmartScreen will notify us with a full-screen warning,

. The binary number system uses only two symbols 0 and 1. That is why this is called binary

because bi means two. Since, only two symbols are used in the binary number system, the
base of this number system, is 2.

. The instructions must be remembered in the making of a flowchart are :

(a) Always begin the flowchart with start symbol.

(b) Do not forget to mark arrows on the flowchart to show the direction of flow of
information.

(c} Use appropriate symbols for each step in the flowchart.
(d) Mark the end of flowchart with stop symbol.

. RDBMS is a software in which information is stored in smaller tables. The tables are linked

onh common fields.
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. (c}; 2. (b); 3. (a); 4. (a); 5. (d)
. True; 2. True; 3. True; 4. False; 5. True

1. Anchors; 2. different; 3. Fill with Color; 4. Hypertext Markup Language; 5. electronic
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. There are four different types of Type Tools :

T Horizontal Type Tool T

IT Vertical Type Tool T

T Horizontal Type Mask Tool T

IT Vertical Type Mask Tool T

. It is programming language in which we can write code in the form of classes something
similar to classic C++ language. Java is also a platform independent language.

. Animation is the illusion of movement created by displaying a series of images in an ordered
manner, very quickly. Generally each image is slightly different from the previous one.

. Call centre is a new dimension in online business that provides services and information to
its customers anywhere in the world.

. It refers to a voice communication is which an audio like is established between two persons
situated far-off from each other. Audio conferencing does not require a computer, rather
needs a two way audio communication facility.
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